ARTICLE INFO

Article history:
Received Dec 29, 2022
Revised Jan 10, 2023
Accepted Jan 12, 2023

Keywords:
Spatial Ability
Discovery Learning
Geogebra
Three Dimensional

ABSTRACT

The purpose of this research is to develop three-dimensional teaching materials using Geogebra-assisted discovery learning models that are valid, practical, and effective. The research method used is development using the ADDIE model, in this study it only reached the development stage, the research instrument used was material expert and media expert validation sheets as well as student response practicality sheets and ability tests in the form of tests in the form of exam questions as many as 5 questions. The research subjects for the limited test were 10 students of class 12-IPA-7. For the broad test, there were 37 students in class 12-IPS-1. Based on the results of the research that has been done, it was found that the analysis of the validation results of material experts was 4.21 with a percentage of 84.11% in the very valid category and media expert validation was 4.19 with a percentage of 83.79% in very valid category. In the limited test, analysis of the results of the practicality sheet of 10 students obtained an average percentage of 69.17% in the practical category and in the broad test of 37 students obtained an average percentage of 83.76% in the very practical category. In the effectiveness test it was obtained that 81.05% were in the Very Good criteria. Thus, the three-dimensional teaching materials using the geogebra-assisted discovery learning model are eligible to meet valid and practical criteria for use in learning mathematics. In the effectiveness test it was obtained that 81.05% were in the Very Good criteria.

INTRODUCTION

According to Piaget & Inhelder 1971 (in Oktaviana, 2016:347), spatial ability is an abstract concept that encompasses visual relations (the capacity to observe the relationship of object
positions in space), frames of reference (signs used as benchmarks to determine the position of objects in space), projective relationships (the capacity to see objects from various points of view), distance conservation (the capacity to estimate the distance between two points), visual representation (the capacity to understand relationships between objects from different points of view), and (imagining the rotation of objects in space). According to Maier (in Fajri: 2016), spatial ability can be broken down into five categories: perceptual ability, visualization ability, rotation ability, relational ability, and orientation ability. These categories are as follows: a) perceptual ability; b) visualization ability; c) rotation ability; and d) relational ability. According to the two views presented above on the subject of spatial ability, it may be said that this mental faculty deals with comprehending, adjusting, rotating, and interpreting visual relationships. This definition makes it clear that mastering geometry requires strong spatial skills. Matter in three dimensions makes up a portion of the geometry. (Soraya et al., n.d.). There are five talents that are produced through the teaching of materials, according to NCTM (2000). The talents include spatial aptitude, interpersonal aptitude, communication aptitude, critical thinking aptitude, and representational aptitude (to describe). (Hawari, n.d.).

Students' mathematical aptitude is relatively low, particularly in the subject of geometry. The PISA (Program for International Student Assessment) scores of Indonesian pupils show that this. They are very low. According to the most recent PISA results from 2018, Indonesian students are rated 74th out of 79 countries. The students' National Exam results on geometry material with absorption support the UN findings that students' retention of the subject matter is still very low. It barely averaged 52.04 in 2015 (BNSP, 2015), decreased to 47.19 in 2016, and only reached 48.57 in 2017. (BNSP, 2017). (Usman et al., 2020).

Students' spatial skills are equally crucial to their mathematical ability. "The pupils that have excellent mathematics achievement have more success in spatial visualizing success than others," according to Yenilmez & Kakmaci (2015). Higher order thinking capabilities can be impacted by pupils' spatial abilities. According to Barke and Engida (2001), spatial ability is the primary indicator of intelligence and is crucial for learning subjects like mathematics and science as well as for many other occupations. (Hendriana et al., nd).

According to Guze and Sener (2009), children who want to master mathematics, particularly geometry, need to have strong spatial reasoning skills. However, Mariani, et al. (2014) noted that kids continue to have trouble learning geometry. (Lalan et al., 2015).

Each pupil has unique spatial ability, which is related. The difference in mathematical aptitude is the one that is most frequently investigated. Students that have stronger beginning ability can master new concepts better, according to Dahar (Nurmayan, 2015:10). (Soraya et al., n.d.).

This is in reference to research from the Nationalof Science (2006) published in Krisnapribadi (2016), which suggests that every student should work to improve their spatial-sensing skills because they are crucial for comprehending relationships and properties in geometry as well as for resolving everyday problems and mathematical issues. (Soraya et al., n.d.).

This was supported by Nemeth's research (Syahputra, 2013), which revealed the significance of spatial abilities in mathematics and engineering, particularly geometry. According to several research findings, kids' spatial skills are still lacking. For instance, Sutadnyana (2013) came to the conclusion that the findings were quite disappointing because most students had trouble answering arithmetic problems, especially three-dimensional issues that required geometric spatial abilities. (Adam & Zulkarnaen, 2019). According to Mulyadi, Riyadi, and Subanti's (2015) research analysis, students made the majority of mistakes when using their
mathematical spatial abilities to convert and draw inferences about geometric objects. (Usman et al., 2020). The study of the relationships between points, lines, angles, planes, and shapes is known as geometry (Ulum, B., Budiarto, MT, & Ekawati, 2017). (Meldie, n.d.).

(In Munawar, Hasyim & Ma'arif, 2020) Febiharsa & Djuniadi. The creation of digitally based instructional materials has as its goal making learning more adaptable. teaching resources Today's technology is highly diverse, bringing up pictures, photos, videos, and animation that are intended to help pupils understand lessons. According to Mahardhika (in Munawar et al., 2020), the focus of digital teaching materials should be on how simple it is for students to understand the subject. This means that learning media can draw in learners. According to Ansadena & Doriza's research, teaching materials should be designed to support these processes as well as draw students' attention (In Munawar, et al., 2020). (Nina Kodariah, 2022).

A learning strategy called discovery learning seeks to make learning meaningful. The following steps are included in the discovery learning process: stimulus (stimulus), problem identification (problem statement), data collection (data collection), data processing (data processing), verification (verification), and generalization (generalization). (Hutapea, 2019). Discovery learning, according to Akamnu & Fajemidagba [3], is learning when students construct their own knowledge by experimentation and draw conclusions about rules or concepts from the findings of these investigations. Dewey claimed that discovery learning is a philosophy and technique for education that focuses on being proactive and giving pupils opportunities to learn [4]. Students can learn to create their own knowledge more successfully by using the discovery technique [5]. (Priatna et al., n.d.).

Another definition of discovery learning is a learning model in progress. In order for pupils to gain information and skills, learning requires them to actively solve issues (Yuliana, 2018: 22; The focus of discovery learning is more on the learner than the teacher (Fajri, 2019: 64). (Anik Dwi Nurmawati et al., 2022). Discovery Learning will have distinguishing characteristics or traits that set it apart from other learning methods (Kim, Park, Min, & Kim, 2021). (Yadi & Nirvana, 2023). Numerous pertinent studies have been Susanti (2016) reportedly came to the conclusion that the use of the Discovery learning paradigm had a substantial impact on the science abilities of class VIIIA students at Palu Adventist Middle School in biology courses. According to Masayu's research, experimental classrooms using the discovery learning model had improved learning results when compared to classes using traditional techniques. According to Artawan's research findings, there are significant differences in the science learning outcomes between students who study using the discovery learning learning model and students who do not study using the discovery learning learning model, based on the findings of statistical tests that had been conducted. (Karaeng & Tulandi, 2022).

GeoGebra is a computer program for teaching mathematics, particularly geometry and algebra, according to Hohenwarter (2008). This program, which may be downloaded from www.geogebra.com, is available for use without charge. Derive, Maple, Mathlab, and other existing computer programs for studying algebra as well as computer applications for learning geometry, such Geometry's Sketchpad or CABRI, are all complemented by the GeoGebra program. Hohenwarter (2008) asserts that GeoGebra is intended to teach geometry and algebra together if these computer applications are used expressly to teach algebra or geometry individually. The File, Edit, View, Options, Tools, Windows, and Help menu items can be found on GeoGebra's main menu when sketching geometric objects. A file can be created, opened, saved, exported, and exited from the program via the File menu. Paintings
can be edited using the Edit menu. The view is chosen using the View menu. The Options menu allows you to customize a number of display characteristics, including text size, geometric object type (style), and more. Finally, technical instructions for using the GeoGebra program are available under the Help menu. (Widyastuti & Hamidah, 2017).

According to study by Oers (2010), students' mathematical thinking skills can develop on their own through games that are connected to their own experiences. According to this study, using Geogebra media gives kids the impression that they are playing with their computers. Fisher explains a second viewpoint (2017) Situations requiring the solution of mathematical puzzles can be handled quickly and simply with GeoGebra.

The production of teaching materials using the Geogebra-assisted Discovery Learning approach in learning is where this research's originality resides, as mentioned before. Therefore, the goal of this research is to create three-dimensional teaching materials utilizing a reliable, useful, and efficient discovery learning approach that uses algebra.

**METHOD**

The research method used is the development research method with the ADDIE model. The purpose of this study was to develop three-dimensional teaching materials using the geogebra-assisted discovery learning model to improve the mathematical spatial abilities of high school students so that the ADDIE model fits perfectly with the products produced. The subjects of this study were 10 students of class 12 IPA-7 SMAN 2 for the limited test and 37 students of class 12-IPS-1. The instrument in this study was a test in the form of a description of 5 questions to measure students' spatial abilities and non-tests in the form of a practicality questionnaire in the form of a Likert scale.

The development of three-dimensional teaching materials using the geogebra-assisted discovery learning model follows the ADDIE development steps which have five stages which form the basis for the method used to create geogebra-assisted three-dimensional educational materials. 1) Analysis: During this phase, the researcher examines the need to create new items (models, methodologies, media, and teaching materials), as well as the feasibility and specifications for their manufacture. The creation of a new product can start with a problem with an existing product. Problems can arise when an old product no longer fits the needs, learning environment, technology, student characteristics, etc. 2) Design: The design phase is a method procedure that starts with the concept and content of the product. 3) Development: At this stage, teaching materials are developed, validated, and corrected based on validator recommendations. Professional teams, including media and content experts, validate educational resources. Teaching materials have been improved based on comments from media and material experts. Practicality is assessed by distributing questionnaires to students, while effectiveness is determined based on the results of the spatial ability test given following the lesson by utilizing the teaching resources made. By offering validation questionnaires, practicality tests, and descriptive questions to assess effectiveness, a data collection and analysis approach was undertaken. Assessment of validity and applicability uses a Likert scale with values 1, 2, 3, and 4. The formula determines the average percentage score of validity and practicality criteria. Validating educational resources. Teaching materials have been improved based on comments from media and material experts. Practicality is assessed by distributing questionnaires to students, while effectiveness is determined based on the results of the spatial ability test given following the lesson by utilizing the teaching resources made. By offering validation questionnaires, practicality tests, and descriptive questions to assess effectiveness, a data collection and analysis approach was undertaken. The formula determines the average percentage score of validity and practicality criteria.
validating educational resources. Teaching materials have been improved based on comments from media and material experts. Practicality is assessed by distributing questionnaires to students, while effectiveness is determined based on the results of the spatial ability test given following the lesson by utilizing the teaching resources made. By offering validation questionnaires, practicality tests, and descriptive questions to assess effectiveness, a data collection and analysis approach was undertaken. Assessment of validity and applicability uses a Likert scale with values 1, 2, 3, and 4. The formula determines the average percentage score of validity and practicality criteria. while the effectiveness is determined based on the results of the spatial ability test given following the learning by utilizing the teaching resources made. By offering validation questionnaires, practicality tests, and descriptive questions to assess effectiveness, a data collection and analysis approach was undertaken. Assessment of validity and applicability uses a Likert scale with values 1, 2, 3, and 4. The formula determines the average percentage score of validity and practicality criteria. while the effectiveness is determined based on the results of the spatial ability test given following the learning by utilizing the teaching resources made. By offering validation questionnaires, practicality tests, and descriptive questions to assess effectiveness, a data collection and analysis approach was undertaken. Assessment of validity and applicability uses a Likert scale with values 1, 2, 3, and 4. The formula determines the average percentage score of validity and practicality criteria.

$$SV = \frac{Sr}{Sm} \times 100\%$$

*Information:*
- **SV** = % of the average validation score
- **Sr** = Average validation score for each validator
- **Sm** = Highest possible score.

**Table 1. Standards of Practicality and Validation of Teaching Materials**

<table>
<thead>
<tr>
<th>SV</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>81 % - 100%</td>
<td>Very Valid / very Practical</td>
</tr>
<tr>
<td>61 % - 80 %</td>
<td>Valid/Practical</td>
</tr>
<tr>
<td>41% - 60%</td>
<td>Valid Enough/Practical Enough</td>
</tr>
<tr>
<td>21% - 40%</td>
<td>Less Valid / Less Practical</td>
</tr>
<tr>
<td>0% - 20%</td>
<td>Very Less Valid / Very Less Practical</td>
</tr>
</tbody>
</table>

(Sugandi et al., 2022)

The quality of teaching materials can be judged by how well students handle the five three-dimensional problems, as measured by their spatial reasoning scores. Student posttest results are calculated by using the following formula:

$$P = \frac{Ns}{Sm} \times 100\%$$

*Information:*
- **P** = Percentage
- **Ns** = Number of Scores obtained
- **Sm** = Maximum Score

The value obtained is calculated as a percentage of students' spatial abilities using the following categories.
Table 2. Interpretation of students' mathematical spatial abilities

<table>
<thead>
<tr>
<th>Percentage (%)</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-20</td>
<td>Very Less Good</td>
</tr>
<tr>
<td>21-40</td>
<td>Not good</td>
</tr>
<tr>
<td>41-60</td>
<td>Pretty good</td>
</tr>
<tr>
<td>61-80</td>
<td>Well</td>
</tr>
<tr>
<td>81-100</td>
<td>Very good</td>
</tr>
</tbody>
</table>

The test results were analyzed based on each indicator by calculating the percentage.

4) Implementation; At this stage, the ADDIE model design and methods that have been developed are implemented in real situations in class. The material is delivered in accordance with the new models and methods developed. After the implementation of the methods and models has been carried out, an initial evaluation is carried out to provide feedback on the development of the next model/method.

5) Evaluation; Evaluation is carried out after the three-dimensional material is delivered, to measure the competency of the material or the learning objectives to be achieved.

RESULTS AND DISCUSSION

Results
The research results are presented based on the stages of ADDIE development, the explanation is as follows:

In the analysis stage, the main activity is to analyze the need for developing teaching materials in learning objectives, some of the analyzes carried out are as follows:

a. Performance analysis
In this stage, given the basic problems encountered in learning.

b. Student analysis
Student analysis is a study of student characteristics based on their knowledge, skills and development. This analysis aims to determine the various levels of student abilities. The results of student analysis regarding spatial abilities can be used as an illustration in developing teaching materials in learning. Some of the points that need to be obtained in this stage include:

- Characteristics of students with regard to learning
- Knowledge and skills that students already have with regard to learning
- Spatial abilities that students need to have in learning
- Forms of developing teaching materials needed by students in order to improve their spatial abilities.

c. Analysis of facts, concepts, principles and procedures of learning materials.
Material analysis with regard to facts, concepts, principles and procedures is a form of identification of the material so that it is relevant to the development of teaching materials in learning. In this stage, the analysis was carried out using the literature study method. The purpose of the analysis of facts, concepts, principles and procedures of learning materials is to identify the main parts of the material to be taught and arranged systematically. This analysis can be used as a basis for formulating learning objectives.

d. Analysis of learning objectives
Analysis of learning objectives is a necessary step to determine the abilities or competencies that students need to have. At this stage, there are a number of points that need to be obtained including:

- Predetermined learning objectives
• Achievement of learning objectives

Thus, this stage can be used as a reference for developing teaching materials in learning.

After carrying out the analysis phase, then carry out the design stage for the design of teaching materials and good formats based on the results of the analysis of the concept of assignments and student characteristics. The application or software that will be used is Geogebra. The initial display of teaching materials is adjusted to its application as an initial introduction to students which can be seen in Figure 1 below.

![Figure 1. Three Dimensional Teaching Materials](image)

The stages and steps for making mathematics teaching materials using the Geogebra application are as follows: determining the need for teaching materials, designing materials, validating designs, revising designs, testing materials, revising materials, perfecting materials, and making materials. The following shows the contents of the sheet in teaching materials

![Figure 2. Point to point distance](image)

![Figure 3. Distance of point to line](image)
At the development stage, validation is carried out on the teaching materials that have been designed, by providing teaching material products to the validator, the validator provides an assessment available on the validation sheet, revision of teaching materials, re-validated by the validator, after obtaining valid quality, then tested on learning activities. This three-dimensional teaching material was validated by 3 material expert validators and 1 ICT expert validator. The validation results from material experts are presented in table 3.

Based on the results of the material expert validation in table 3 above, the average score of the material expert validator is 4.21 with a percentage of 84.11% and is in a very valid category. However, there are suggestions and input provided by the material validator, namely: 1) clear learning objectives regarding the three dimensions must be added, 2) teaching materials are designed to sufficient time allotted for one meeting. Furthermore, the results of the assessment of ICT expert validators on Geogebra were carried out by productive teachers in the computer department, the results of the validation are presented in table 4.

**Figure 4.** Distance from point to plane
Based on the results of the ICT expert validation in table 4 above, the average score of the ICT expert validator is 4.19 with a percentage of 83.79% and is in a very valid category. However, there are suggestions and inputs provided by the ICT expert validator, namely: 1) it must be added to the designation of signs for points to points, points to lines and points to planes, 2) equipped with names and given a description of the geogebra application.

From the results of the validation of material experts and ICT experts, it was concluded that the three dimensional teaching materials developed were in the very valid category, in terms of content, presentation, graphics. Thus, the developed three-dimensional teaching materials on GeoGebra rock spatial abilities are feasible to be tested in the field after being revised according to suggestions and input from material expert validators and ICT experts.

Furthermore, limited tests and broad tests were carried out to determine the practicality of three-dimensional teaching materials on GeoGebra-assisted spatial abilities. Based on the results of practicality questionnaire data processing in the limited test presented in table 5 below.

**Table 5. Practicality Results in the Limited Test**

<table>
<thead>
<tr>
<th>Rated aspect</th>
<th>Score</th>
<th>Percentage</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependency</td>
<td>140</td>
<td>70</td>
<td>Practical</td>
</tr>
<tr>
<td>Confidence</td>
<td>138</td>
<td>69</td>
<td>Practical</td>
</tr>
<tr>
<td>Behave Discipline</td>
<td>139</td>
<td>70</td>
<td>Practical</td>
</tr>
<tr>
<td>Have initiative</td>
<td>139</td>
<td>70</td>
<td>Practical</td>
</tr>
<tr>
<td>Responsibility</td>
<td>136</td>
<td>68</td>
<td>Practical</td>
</tr>
<tr>
<td>Self control</td>
<td>138</td>
<td>69</td>
<td>Practical</td>
</tr>
<tr>
<td><strong>Average score</strong></td>
<td><strong>138.33</strong></td>
<td><strong>69.17</strong></td>
<td>Practical</td>
</tr>
</tbody>
</table>

Based on the results of the practicality test in table 5 above, it shows that aspects of dependence, self-confidence, disciplined behavior, initiative, sense of responsibility, and self-control are in the Practical category as a whole the practicality of the teaching materials tested is limited to the Practical category. After conducting a limited test, the researcher made improvements to the product and then carried out a broad test. The results of the practicality of teaching materials in the broad test are presented in table 6 below.

**Table 6. Practicality Results in the Broad Test**

<table>
<thead>
<tr>
<th>Rated aspect</th>
<th>Score</th>
<th>Percentage</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dependency</td>
<td>582</td>
<td>83.14</td>
<td>Very Practical</td>
</tr>
<tr>
<td>Confidence</td>
<td>573</td>
<td>81.86</td>
<td>Very Practical</td>
</tr>
<tr>
<td>Behave Discipline</td>
<td>556</td>
<td>79.43</td>
<td>Practical</td>
</tr>
<tr>
<td>Have initiative</td>
<td>614</td>
<td>87.71</td>
<td>Very Practical</td>
</tr>
<tr>
<td>Responsibility</td>
<td>611</td>
<td>87.29</td>
<td>Very Practical</td>
</tr>
<tr>
<td>Self control</td>
<td>582</td>
<td>83.14</td>
<td>Very Practical</td>
</tr>
<tr>
<td><strong>Average score</strong></td>
<td><strong>586</strong></td>
<td><strong>83.76</strong></td>
<td><strong>Very Practical</strong></td>
</tr>
</tbody>
</table>

Based on the results of the practicality test in table 6 above, it shows that the aspects of dependency, self-confidence, having initiative, a sense of responsibility, and self-control are in the Very Practical interpretation, only the aspects of disciplinary behavior are in the Practical interpretation, but overall the practicality of the teaching materials tested is in the Very Practical interpretation.
In the next stage, namely implementing teaching materials while at the same time wanting to know the evaluation results that had been developed in learning mathematics in class XII at the end of the meeting, students were given test questions to measure spatial abilities with several indicators. The results of the mathematical spatial ability test are presented in table 7 below:

<table>
<thead>
<tr>
<th>No</th>
<th>Indicator</th>
<th>Percentage</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Identify elements that are known, asked and the adequacy of these elements</td>
<td>82.57</td>
<td>Very good</td>
</tr>
<tr>
<td>2</td>
<td>Describe a flat shape with the questions given</td>
<td>79.73</td>
<td>Well</td>
</tr>
<tr>
<td>3</td>
<td>How to solve questions</td>
<td>80.54</td>
<td>Well</td>
</tr>
<tr>
<td>4</td>
<td>Implement strategies to solve problems or questions</td>
<td>81.35</td>
<td>Very good</td>
</tr>
<tr>
<td>5</td>
<td>Check the correctness of the results</td>
<td>81.05</td>
<td>Very good</td>
</tr>
</tbody>
</table>

In table 7 above, the results of the overall mathematical spatial ability test are 81.05% in Very Good Interpretation. This shows that the developed teaching materials can improve students' mathematical spatial abilities.

Figure 5. Results of the effectiveness sheet on broad test students

In Figure 5, it can be seen that students have very good spatial abilities after being given the teaching materials provided in the development of this research.

Discussions

The purpose of this study was to develop three-dimensional teaching materials using the geogebra-assisted discovery learning model to improve high school students' mathematical spatial abilities so that the ADDIE model. First Stage of Analysis: During this stage, the researcher examines the need to manufacture the new item (model, methodology, media, and raw materials), as well as the feasibility and specifications for its manufacture. The creation of a new product can start with a problem with an existing product. Problems can arise when an old product no longer fits the needs, learning environment, technology, student characteristics, etc. Second Stage of Design: The design phase is a method procedure that begins with the concept and content of the product. Third Stage of Development: At this stage, teaching materials are developed, validated, and improved based on validator recommendations. Professional teams, including media and content experts, validate educational resources. Teaching materials have been improved based on comments from media and material experts. Practicality is assessed by distributing questionnaires to students, while effectiveness is
determined based on the results of the spatial ability test that is given following the lesson by utilizing the learning resources that are made. The fourth stage of Implementation; At this stage, the ADDIE model design and methods that have been developed are implemented in real situations in class. The material is delivered in accordance with the new models and methods developed. After the implementation of the methods and models is carried out, an initial evaluation is carried out to provide feedback on the development of the next model/method. Fifth evaluation; Evaluation is carried out after the three-dimensional material is delivered, to measure the capacity of the material or the learning objectives to be achieved. The development of this teaching material is based on the teacher's lack of innovation in learning, in learning in the classroom researchers use the discovery learning model. Discovery Learning will have markers or features that make it different from other learning models (Kim, Park, Min, & Kim, 2021). This strengthens Nemeth (Syahputra, 2013) in his research finding the importance of spatial abilities that are needed in engineering and mathematics, especially geometry. Some research results show that students' spatial abilities are still weak. For example, Sutadnyana (2013) concluded that most students had difficulty solving math problems, especially three-dimensional problems that required geometric spatial abilities, so the results were very unsatisfactory. (Adam & Zulkarnaen, 2019).

CONCLUSION

The research results are presented based on the ADDIE development stages, the research is limited to the development stage, starting from analysis, design, development, three-dimensional teaching materials are validated by 3 material expert validators and 1 ICT expert validator. The research instruments used were material expert and media expert validation sheets as well as student response practicality sheets and ability tests in the form of tests in the form of 5 questions. The research subjects for the limited test were 10 students of class 12 IPA-7. For the broad test, there are 37 students in class 12-IPS-1. Based on the results of the research that has been done, it is found that the analysis of the results of the validation of material experts is 4.21 with a percentage of 84.11% in the very valid category and media expert validation is 4.19 with a percentage of 83.79% in the very valid category. In the limited test, analysis of the results of the practicality sheet of 10 students obtained an average percentage of 69.17% in the practical category and in the broad test of 37 students obtained an average percentage of 83.76% in the very practical category. In the effectiveness test, it was found that 81.05% was in Very Good criteria. The purpose of this research is to develop three-dimensional teaching materials using Geogebra-assisted discovery learning models that are valid, practical, and effective. Thus, the three-dimensional teaching materials using the geogebra-assisted discovery learning model are eligible to meet very valid and practical criteria for use in learning mathematics.

ACKNOWLEDGMENTS

Alhamdulillah, first of all, all praise be to the presence of Allah the Almighty, for all His blessings, inayah, taufik, and guidance so that I can complete the preparation of this journal, and don't forget to send prayers and greetings to the Prophet Muhammad, his family and friends, as well as the followers until the end of time.

In the process of researching and compiling this journal, of course there were many parties who helped, we would like to thank those who have assisted in the research and preparation of the journal, including thanks for:

1. Lecturers of S-2 Mathematics Department of IKIP Siliwangi
2. Parents who have given us encouragement
3. Wives and children who have encouraged and have helped both morally and materially.
4. As well as friends in arms class of 2021 majoring in S-2 Mathematics IKIP Siliwangi.
5. And don't forget the students who have helped finish this journal, as well as related parties who cannot be mentioned one by one.

REFERENCES

Hawari, N. W. (n.d.). UPAYA MENGEMBANGKAN KEMAMPUAN SPASIAL SISWA KELAS IX SMP AL-WASHLIYAH 34 BANDAR TINGGI MELALUI TEORI BELAJAR VAN HIELE.
Meldi, N. F. (n.d.). MISKONSEPSI PESERTA DIDIK PADA MATERI GEOMETRI DAN SOLUSINYA DI SEKOLAH NON FORMAL.
